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第 2 章 开门见山——Linux 系统安装 

 

本章目标 

 

不管学习操作系统还是其他应用软件，首先必须在自己的计算机上安装。Linux

的各种发行版为了简化操作，都提供了一套自己的安装方法。在本章中首先为大家

讲解 Linux 的一些基本知识及如何安装 Linux 操作系统。 
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  使用 VMware Workstation 搭建测试环境 

VMware Workstation 是 VMware 公司（VMware 中文官方网站：http:// www.vmware.com/cn/）销售的

商业软件产品之一，该软件包含一个用于英特尔 x86 兼容计算机的虚拟化套件，允许多个 x86 虚拟机同时

被创建和运行。每个虚拟机实例可以运行其自己的客户机操作系统，比如（但不限于）Windows、Linux、

BSD 等。简单地说，VMware Workstation 允许一台真实的计算机同时运行数个操作系统。 

VMware Workstation 提供了这样一个机会：可以在一台机器上真正同时运行两个（或多个）独立的操

作系统，一个是原始的操作系统，一个运行于虚拟机上。基于上述原因，你现在可以在运行 Windows 平台

的计算机上通过 VMware Workstation 安装并运行 Linux，反之亦然。事实上两个操作系统之间并没有太多

的依赖关系，也可以在 Linux 上再装一个 Linux，或者在 Windows XP 下装一个 Windows 7。使用 VMware 

Workstation 关键的好处在于，安装新的操作系统时并不需要重新划分硬盘空间，不会破坏原有的系统结构，

也可以同时运行多个操作系统而不需要重新启动计算机。VMware Workstation 还提供了快照功能，通过该

功能可以对虚拟机备份，这一点对初学者来说是非常有用的。 

在 VMware Workstation 安装完成后（本章中使用的是 VMware Workstation 7.0），在“开始”→“所有

程序”打开“VMware”后单击“VMware Workstation”按钮即可启动该软件。由于 VMware Workstation

默认的一些快捷键与 Linux 系统的快捷键有冲突，推荐在 VMware Workstation 的“Edit”→“Preferences”

→“Hot Keys”中将 VMware Workstation 在虚拟机切换到宿主机的快捷键修改为“Ctrl+Shift+Alt”或其他

快捷键，如图 2-1 所示，修改后需要关闭 VMware Workstation 并重新打开配置才会生效。 

 
图 2-1  修改 VMware Workstation 快捷键 

2.1.1  新建虚拟机 

使用 VMware Workstation 搭建测试环境时，首先需要建立虚拟机，具体操作步骤如下。 

（1）在 VMware Workstation 中选择“File”→“New”→“Virtual Machine…”，在弹出的窗口中选择

“Custom(advanced)”后，单击“Next”按钮，如图 2-2 所示。 

 
图 2-2  建立虚拟机 
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（2）选择 VMware Workstation 建立虚拟机的版本。和其他大部分软件一样 VMware Workstation 所建立

的虚拟机只保证向下兼容，即 VMware Workstation 6.0 所建立的虚拟机使用 VMware Workstation 7.0 可以运

行，但反之则不一定。如果希望 VMware Workstation 7.0 建立的虚拟机可以被 VMware Workstation 7.0 以下

的版本打开，这里就需要选择建立较低版本的虚拟机（本章中不考虑使用老版本的 VMware Workstation，

所以直接单击“Next”按钮），如图 2-3 所示。 

 
图 2-3  选择虚拟机版本 

（3）在选择虚拟机使用的光盘界面选择“I will install the operating system later.”后直接单击“Next”

按钮，此部分可在虚拟机建立完成后再放入光盘，如图 2-4 所示。 

 
图 2-4  选择虚拟机使用光盘 

（4）选择在虚拟机中使用操作系统，该部分可以根据自己的需要配置，本章中选择“Linux”→“Red 

Hat Enterprise Linux 5”。选择完成后单击“Next”按钮，如图 2-5 所示。 

 
图 2-5  虚拟机操作系统版本 
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（5）输入虚拟机的标题及保存的路径。该界面中虚拟机的标题只是在 VMware Workstation 中显示的并

不是虚拟机的主机名。虚拟机中所有的内容都是以文件的形式保存在宿主机的硬盘中，在该界面中还需要

输入虚拟机的文件保存在宿主机硬盘的位置，输入完成后单击“Next”按钮，如图 2-6 所示。 

 
图 2-6  虚拟机标题及保存路径 

（6）选择虚拟机所使用的物理内存。对于 Linux 的初学者需要使用图形界面的情况下，推荐分配 512MB

以上的内存，输入完成后单击“Next”按钮，如图 2-7 所示。 

 
图 2-7  虚拟机使用物理内存 

（7）选择网络类型，在本章中选择“Use host-only networking”，至于其他网络类型的功能本章后续内

容中会加以说明，选择完成后单击“Next”按钮，如图 2-8 所示。 

 
图 2-8  选择网络类型 
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（8）选择虚拟机使用的 SCSI 接口类型，该界面可保持默认值直接单击“Next”按钮。 

（9）选择“Create a new virtual disk”为虚拟机建立一个新的虚拟硬盘，如图 2-9 所示。 

 
图 2-9  新建虚拟机硬盘 

（10）选择虚拟硬盘是使用 IDE 还是 SCSI 接口，该界面可保持默认值直接单击“Next”按钮，如图

2-10 所示。 

 
图 2-10  选择虚拟机硬盘接口 

（11）输入虚拟硬盘的容量，在默认情况下该容量只是一个上限，虚拟硬盘占用宿主机物理硬盘的实

际大小是以虚拟机中保存数据的大小为准的，输入完成后单击“Next”按钮，如图 2-11 所示。 

 
图 2-11  虚拟硬盘大小 
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（12）选择虚拟硬盘在宿主机物理硬盘的保存目录及文件名，默认情况下虚拟硬盘保存在虚拟机所在

目录，输入完成后单击“Next”按钮，如图 2-12 所示。 

 
图 2-12  虚拟硬盘文件所在目录 

（13）完成上述配置后，单击“Finish”按钮完成虚拟机的新建，如图 2-13 所示。 

 
图 2-13  完成新建虚拟机 

（14）完成虚拟机的新建后，可以单击如图 2-14 所示的绿色按钮运行虚拟机。 

 
图 2-14  运行虚拟机 
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2.1.2  虚拟机基本操作 

VMware Workstation 的功能非常强大，但对于初学者在使用 VMware Workstation 作为学习工具时常用

的操作一般会有以下几种。 

启动、暂停、停止虚拟机 

在“开始”→“所有程序”打开“VMware”单击“VMware Workstation”按钮启动 VMware Workstation

后，可通过“File”→“Open…”打开虚拟机。通过如图 2-15 所示工具栏中启动、暂停、停止按钮运行、

暂停、停止及重新启动虚拟机。 

 
图 2-15  启动、暂停、停止及重新启动虚拟机 

如果在虚拟机运行过程中直接关闭VMware Workstation，会弹出如图 2-16所示的窗口，其中“Suspend”

表示暂停所有未关闭的虚拟机，“Power Off”表示关闭所有未关闭的虚拟机，“Run in Background”表示将

所有未关闭的虚拟机转到后台运行。 

 
图 2-16  关闭 VMware Workstation 

将光盘放入虚拟机光驱 

在使用真实机时，可以使用CD、DVD或通过虚拟光驱软件挂载 ISO文件的方式来使用光盘，在VMware 

Workstation 创建的虚拟机中使用光盘的方法有以下两种。 
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图 2-17  使用宿主机光驱 

（1）使用宿主机的光驱。在 VMware Workstation 创建的虚拟机中可以直接将宿主机光盘的内容映射到

虚拟机的光驱中，可以在虚拟机未运行时。单击“Edit virtual machine settings”按钮后在弹出窗口中选择

“CD/DVD”，在“Connection”中选择“Use physical drive:”，然后选择需要使用的物理光驱，如图 2-17 所

示，也可以在虚拟机运行过程中单击 VMware Workstation 右下角光驱在弹出窗口中进行修改，如图 2-18

所示。 

 
图 2-18  使用宿主机光驱 

（2）使用 ISO 文件。使用 ISO 文件作为虚拟机光驱内容的配置界面和使用宿主机的光驱相同，只需选

择“Use ISO image file:”后，单击“Browse”按钮选择 ISO 文件即可。 

调整虚拟机硬件配置 

在使用 VMware Workstation 运行虚拟机时，可以根据需要增加或修改虚拟机的硬件配置，大部分的硬

件配置修改必须在虚拟机处于关机模式时，才可以进行。 

如果需要修改虚拟机硬件配置，只需单击“Edit virtual machine settings”按钮（如图 2-19 所示）后，

在弹出窗口中进行操作。 

虚拟机截图及操作录像 

VMware Workstation 提供了对虚拟机中的操作进行截图及录像的功能。如果需要截图，在虚拟机运行

后选择“VM”→“Capture Screen”；如果对虚拟机中的操作进行录像，在虚拟机运行后选择“VM”→“Capture 

Movie”。 
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快照功能使用 

很多读者在使用自己的计算机时，经常在安装完系统及各种应用软件后，习惯使用 Ghost 对系统进行

备份，如果以后在使用过程中系统出了问题，可以直接使用 Ghost 快速地还原系统。在 VMware Workstation

中，也可以通过快照功能对虚拟机进行类似的操作。快照功能可以快速地备份/恢复虚拟机的内容，这一点

对于初学者是非常有用的，在虚拟机中安装 RHEL 5.x 后先进行一个快照，这样以后可以快速地还原到刚

安装好系统的状态。 

 
图 2-19  调整虚拟机硬件配置 

无论虚拟机在运行还是停止状态，选择“VM”→“Snapshot”→“Take Snapshot”，在弹出窗口中为

快照起一个名字并单击“OK”按钮，如图 2-20 所示，即可对当前虚拟机进行一次快照，VMware Workstation

支持对一个虚拟机进行多次快照。 

 
图 2-20  快照功能 

快照完成后，无论虚拟机在运行还是停止状态，如果需要恢复虚拟机可以选择“VM”→“Snapshot 

Manager”，在弹出的窗口中会显示所有对当前虚拟机的快照，如图 2-21 所示，双击快照名称即可恢复快照。 

 
图 2-21  恢复快照 
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2.1.3  虚拟机网络模式 

在使用 VMware Workstation 时，经常需要让虚拟机与宿主机或虚拟机与宿主机所在网络其他计算机进

行通信，这时就需要正确地配置虚拟机网卡的网络模式。在 VMware Workstation 安装完成后，会在宿主机

增加如下的虚拟设备。 

（1）VMnet0：用于虚拟桥接网络下的虚拟交换机。 

（2）VMnet1：用于虚拟 Host-Only 网络下的虚拟交换机。 

（3）VMnet8：用于虚拟 NAT 网络下的虚拟交换机。 

（4）VMware Network Adapter VMnet1：宿主机用于与 Host-Only 虚拟网络进行通信的虚拟网卡。 

（5）VMware Network Adapter VMnet8：宿主机用于与 NAT 虚拟网络进行通信的虚拟网卡。 

修改虚拟机网络模式可以在虚拟机未运行时通过单击“Edit virtual machine settings”按钮后，在弹出

的窗口中选择对应网络接口进行修改，如图2-22所示。也可以在虚拟机运行过程中单击VMware Workstation

右下角对应网络接口在弹出窗口中进行修改，如图 2-23 所示。 

 
图 2-22  配置虚拟机网卡网络模式（1） 

 
图 2-23  配置虚拟机网卡网络模式（2） 

VMware Workstation 中提供了以下三种网络模式。 

1．桥接模式 

宿主机的物理网卡和虚拟机的网卡在 VMnet0 交换机上通过虚拟网桥进行桥接，也就是说，宿主机的

物理网卡和虚拟机的虚拟网卡处于同等地位，此时的虚拟机就好像宿主机所在的一个网段上的另外一台机

器，如图 2-24 所示。 
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虚拟机 

宿主机网卡

虚拟机网卡

 
图 2-24  桥接模式 

假设宿主机的物理网卡 IP 地址为 192.168.159.10、默认网关为 192.168.159.1；虚拟机的虚拟网卡 IP 地

址为 192.168.159.11、默认网关为 192.168.159.1，如果虚拟机的虚拟网卡配置为桥接模式时，只要是可以

和宿主机进行通信的网络设备就可以和虚拟机进行通信。 

2．Host-Only 模式 

Host-Only 网络被用来设计成一个与外界隔绝的网络，其实 Host-Only 网络和 NAT 网络非常相似，唯

一不同的地方就是在 Host-Only 网络中，没有用到 NAT 服务，没有服务器为 VMnet1 网络做路由，当然就

没有办法访问 Internet，如果此时宿主机需要与虚拟机通信就要用到 VMware Network Adapter VMnet1 这块

虚拟网卡，如图 2-25 所示。 

 
图 2-25  Host-Only 模式 

VMware Workstation 在安装时，会为 VMware Network Adapter VMnet1 虚拟网卡随机指定一个 IP 地址，

同时会安装一个 DHCP 服务（在 Windows 服务管理中可以找到该服务，名称为“VMware DHCP Service”），

为虚拟机分配 IP 地址。如果将虚拟机网卡模式设置为 Host-Only，且将虚拟机中 IP 地址配置自动获取或配

置为与VMware Network Adapter VMnet1虚拟网卡同一网段的 IP地址，那么虚拟机与宿主机之间可以通信。 

3．NAT 模式 

在 NAT 网络中，会使用到 VMnet8 虚拟交换机，宿主机上的 VMware Network Adapter VMnet8 虚拟网

卡被连接到 VMnet8 交换机上，与虚拟机进行通信，但是 VMware Network Adapter VMnet8 虚拟网卡仅仅

用于和 VMnet8 网段通信，并不为 VMnet8 网段提供路由功能，处于虚拟 NAT 网络下的虚拟机是使用虚拟

的 NAT 服务器来连接到 Internet 的，如图 2-26 所示。VMware Workstation 功能非常强大，在 NAT 网络下，

可以使用 Port Forwarding 功能，来把宿主机的某一个 TCP 或 UDP 端口映射到虚拟机上。 
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图 2-26  NAT 模式 

VMware Workstation 在安装时，会为 VMware Network Adapter VMnet8 虚拟网卡随机指定一个 IP 地址，

同时会安装一个 DHCP 服务（在 Windows 服务管理中可以找到该服务，名称为“VMware DHCP Service”），

为虚拟机分配 IP 地址。如果将虚拟机网卡模式设置为 NAT，且将虚拟机中 IP 地址配置自动获取，那么虚

拟机会得到一个与 VMware Network Adapter VMnet8 虚拟网卡同一网段的 IP 地址。这时虚拟机可以与宿主

机进行通信，如果宿主机可以访问 Internet，那么虚拟机也可以访问。 

如果使用 VMware Workstation 主要是为了学习且不用访问 Internet，推荐将虚拟机网卡配置为

Host-Only 模式，这样做实验时不会受其他网络中计算机的影响。如果需要在虚拟机中访问宿主机可将虚

拟机 IP 地址与 VMnet1 虚拟网卡配置在同一网段；如果需要访问 Internet，推荐配置为 NAT 模式并将 IP

地址配置为自动获取或与 VMnet8 虚拟网卡在同一网段。 

  Linux 磁盘分区及目录 

在学习 Linux 前首选需要明白，Linux 是一个与大家习惯使用的 Windows 完全不同的操作系统，也许

你已经习惯了开机后右手就放到鼠标上开始操作、习惯了开始菜单、习惯了“Ctrl+C”和“Ctrl+V”，那么

这些在 Linux 中都不是必需的，虽然在 Linux 中也可以使用图形界面操作，但是这绝对不是必需的！你需

要习惯所有一切的操作都通过键盘来完成，需要习惯所有的配置都是通过修改配置文件完成的。 

在开始学习 Linux 的安装前，首先从最基本的磁盘、文件系统、目录在 Linux 中的概念开始。 

2.2.1  Linux 磁盘分区 

和其他操作系统一样，Linux 可以将磁盘划分为多个分区，每个分区可以被当做一个独立的磁盘使用。

在 Linux 中可以将磁盘划分为以下三种类型的分区。 

1．主分区 

主分区可以标记为活动，用于操作系统的引导。在一块磁盘上最多可以划分 4 个主分区。主分区上可

以用于存放操作系统所需文件，也可以用于存放用户数据。 

2．扩展分区 

为了解决一块磁盘只能划分 4 个分区而引入了扩展分区，只有在主分区小于 4 个时才可以划分扩展分

区，在一块磁盘上最多只能有一个扩展分区。扩展分区不能用于保存任何数据，必须在扩展分区中进一步

划分逻辑分区，用户数据只能保存在逻辑分区中。 

3．逻辑分区 
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在扩展分区中可以建立多个逻辑分区。逻辑分区的分区信息作为一个链表存在，所以在理论上讲可以

建立的逻辑分区的数目不受限制。 

在 Windows 中所有的主分区和逻辑分区都是采用英文字母标记，如 C 盘、D 盘等，而在 Linux 中计算

机大多数的硬件设备都是以文件方式进行管理，这些硬件设备都被映射到“/dev”目录下对应的文件中。

磁盘分区也不例外，在“/dev”目录中会将每个磁盘分区映射为一个文件，这些文件采用字母加数据的形

式，其格式如下。 

/dev/xxyN 

其中“xx”表示分区名所在磁盘的设备类型，一般 hd 代表 IDE 接口的磁盘（包括 IDE 接口的光盘驱

动器）；sd 代表 SCSI 或 SATA 接口的磁盘（包括 SCSI 或 SATA 接口的光盘驱动器以及 U 盘）；fd 代表软

盘驱动器。“y”表示分区所在硬盘是当前接口的第几个设备，比如第一个 SCSI 硬盘就是“/dev/sda”、第

二个 SCSI 硬盘就是“/dev/sdb”。“N”表示分区的序号，前 4 个分区（主分区或扩展分区）使用 1～4 表示；

逻辑分区从 5 开始，如图 2-27 所示。 

 
图 2-27  磁盘分区 

在分区完成后，用户并不能直接使用这些分区，需要格式化后再通过 mount 命令（有关 mount 命令见第

7 章 ）挂载后才可以使用。比如使用 mount 命令将“/dev/sdb2”挂载到“/mnt/disk”目录，那么所有保存到

“/mnt/disk”目录的数据就会被保存到“/dev/sdb2”分区中。 

2.2.2  Linux 文件系统及目录结构 

文件系统是一种存储和组织计算机文件及数据的方法，文件系统使得对数据的访问和查找变得容易。

文件系统通常使用硬盘和光盘这样的存储设备，并维护文件在设备中的物理位置。 

在 Windows 中有 FAT、FAT32、NTFS 等文件系统，在 Linux 中推荐使用的是 ext3（第三版 Extende File 

System，扩展文件系统）。目前 ext 文件系统最新的版本是 ext4，但是大多数发行版中还只支持 ext3。 

Linux 操作系统默认可以操作 FAT、FAT32 两种文件系统，由于一些原因默认情况下不支持 NTFS 系

统。目前对于 Linux 操作系统中还是推荐使用 ext3 文件系统。ext3 是一种日志文件系统，在对该系统数据

进行写操作前，将会把写操作的内容写入一个日志文件中，一旦操作被意外中止，系统将能够在重新启动

时根据日志记录完成该写操作。 

在 Linux 的文件系统中，文件是存储信息的基本结构。文件、目录、硬件设备都以文件的形式表现，

文件名可以由字符、数据、圆点、下画线组成，长度不能超过 256 个字符。在 Windows 中通过圆点区分文

件名及扩展名，扩展名对于 Windows 来说非常重要。在 Linux 中通过圆点区分文件名及扩展名可以帮助用

户区分文件类型，但并没有像 Windows 那样有实际的约束力（不会影响文件在系统中的执行），用户可以

根据自己的需要随意给文件加入自己的扩展名。Linux 中的常见的文件可以分为以下 4 种类型。 

（1）普通文件，比如文本文件、图片文件、视频文件、Shell 脚本文件。 

（2）目录文件，在 Windows 中目录和文件是两种不同类型的数据，而在 Linux 中目录被视为文件的一

种。 

（3）链接文件，类似于 Windows 中的快捷方式，在查看时文件名后面会通过箭头“→”指向实际的文

件，如图 2-28 所示。 
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图 2-28  链接文件 

（4）特殊文件，Linux 中的一些设备，如磁盘、打印机等，都是通过文件在文件系统中表现出来，这

类文件就是特殊文件。特殊文件通常存放在“/dev”目录中。 

目前大部分的文件系统都是采用流行的树形目录结构来组织文件，这样的结构中会有一个文件系统的

根，然后在根下有若干的分杈（目录），在这些目录下还可以有目录或文件。Linux 系统也是采用这样的树

形目录结构（如图 2-29 所示），在有足够权限的情况下用户可以进入任何目录，在目录下建立目录或文件，

复制及移动目录或文件。下面是 Linux 中关于目录的几个概念。 

 
图 2-29  目录结构 

（1）当前目录（工作目录），当用户登录到 Linux 系统后，无论做任何操作都会处于某个目录之中，此

类目录就被称为当前目录。用户可以使用“cd”命令随时切换当前目录，如果不清楚当前目录可以通过“pwd”

命令查看当前目录。 

查看当前目录。 

[root@srv ~]# pwd 

/root 

进入/home 目录。 

[root@srv ~]# cd /home 

查看当前目录。 

[root@srv ~]# pwd 

/home 

（2）用户家目录（用户主目录），在 Windows 中每个用户有一个配置文件目录，如果系统安装在 C 盘，

在 Windows Vista 之前的系统中该目录在“C:\Documents and Settings”目录下以用户名为名称的目录中；

在 Windows Vista 之后的系统中该目录在“C:\Users” 目录下以用户名为名称的目录中。在 Linux 中每个

用户也有一个家目录，如果是管理员（root 用户）其家目录是“/root”；如果是普通用户其家目录在“/home” 

下以用户名为名称的目录中。每次用户登录到 Linux 后，默认的当前目录就是该用户的家目录，如图 2-30

所示。 

 
图 2-30  用户家目录 
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（3）路径，从一个目录到另一个目录或文件的道路被称为路径。在 Linux 中路径一般主要由目录名称

组成，目录名称之间使用斜杠“/”分隔。在路径中还有四种特殊的目录名称分别是：“.”表示当前目录；

“..”表示当前目录的父级目录；“~”表示当前用户的家目录；“-”表示上一个工作目录。 

进入/home/charles 目录。 

[root@srv ~]# cd /home/charles 

进入当前目录的上一级目录。 

[root@srv ~]# cd ..  

查看当前目录。 

[root@srv ~]# pwd 

/home 

进入当前用户的家目录。 

[root@srv ~]# cd ~  

查看当前目录。 

[root@srv ~]# pwd 

/home/charles 

返回上一个工作目录。 

[root@srv ~]# cd -         

查看当前目录。 

[root@srv ~]# pwd 

/home 

进入某一个目录或打开某个文件时，可以通过“绝对路径”及“相关对路径”两种方式。绝对路径指

的是目标目录或文件从根开始的路径，必须以“/”开头；相对路径指的是目标目录或文件相对于当前目录

路径。在如图 2-29 所示的目录结构中，假设当前用户是 charles；当前目录是“/etc/rc”，现在想进入

“/home/charles/mail”目录可以通过以下几种方式。 

使用绝对路径。 

[root@srv ~]# cd /home/charles/mail   

使用相对路径。 

[root@srv ~]# cd ../../home/charles/mail    

使用特殊路径。 

[root@srv ~]# cd ~/mail                   

在实际应用中使用“绝对路径”还是“相对路径”并没有一个统一的规定，可以根据自己的习惯或者

选择一种方便的方式。 

  打造 RHEL 5.x 平台 

学习任何操作系统，第一次都需要安装该操作系统，RHEL 5.x 的安装过程与大家已经很熟悉的

Windows 安装过程不太一样，但总体来讲并不太复杂。RedHat 在安装系统时使用的是该公司开发的

Anaconda。Anaconda 使用 Python 及 C 语言编写，可以用来自动安装配置，使用户能够以最小的监督运行。

Anaconda 安装管理程序应用在 RHEL/CentOS、Fedora 和其他一些项目。 
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2.3.1  RHEL 5.x 安装方式 

Linux 先天就可以满足大型应用的各种需求，安装 Linux 同样也有很多种方式，在实际应用中可以根

据实际情况选择不同的安装方式。 

1．光盘安装 

如果计算机上有 CD-ROM（或 DVD-ROM）驱动器，同时也有 RHEL 5.x 的光盘，可以采用光盘安装

的方式。从光盘安装是比较传统也是最直接的方式，不需要其他设备的支持。在整个安装过程中所需的所

有文件都从光盘中获取。 

2．NFS 安装 

如果计算机上没有 CD-ROM（或 DVD-ROM）驱动器，那么访问网络时，可以采用 NFS（Network File 

System）安装 RHEL 5.x。当采用从 NFS 安装的方式时，必须将 RHEL 5.x 光盘（或 ISO 映像文件）挂载到

另一台含有 Rock Ridge 扩展的计算机上。安装时通过启动盘（或 PXE 启动）启动安装过程，输入 NFS 服

务器的 IP 地址和 RHEL 5.x 光盘（或 ISO 映像文件）挂载路径，选择需要的软件包安装到硬盘。  

3．FTP 安装 

通过 FTP 安装时，首先使用启动盘（或 PXE 启动）启动安装过程，再通过网络访问提供了 RHEL 5.x

安装文件的 FTP 站点，然后下载安装文件并安装到本地硬盘。 

4．HTTP 安装 

通过 HTTP 安装时，首先使用启动盘（或 PXE 启动）启动安装过程，再通过网络访问提供了 RHEL 5.x

安装文件的 Web 站点，然后下载安装文件并安装到本地硬盘。 

5．硬盘安装 

硬盘安装方式是将 RHEL 5.x 光盘（或 ISO 映像文件）复制到计算机的一个硬盘上，然后通过启动盘

启动安装进程，并把安装程序指向映像文件目录，开始从硬盘中执行安装过程。 

2.3.2  RHEL 5.x 安装与登录 

使用光盘安装对于初学者来说是最简单的方法，一般在开始学习时首先应该学会使用光盘安装 RHEL 

5.x 的方法。 

（1）将 RHEL 5.x 光盘放入光驱后启动计算机，在图 2-31 所示的界面中按回车键，开始进入安装过程。 

 
图 2-31  开始安装 

（2）在 RHEL 5.x 载入必需的文件后，会提示是否检查安装源（光盘）是否有错误，如确定光盘没有

任何问题，可直接选择“Skip”，如图 2-32 所示。 

 
图 2-32  安装源检查 
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（3）进入图形界面后显示的是欢迎信息，这里可以直接单击“Next”按钮（如图 2-33 所示）。在接下

来每个安装的界面中都有一个“Release Notes”按钮，通过单击这个按钮可以查看与发行版相关的发行说

明。 

 
图 2-33  进入图形界面 

（4）选择显示语言，这里推荐选择“English（English）”。如果对英语不太熟悉或是初学者也可以选择

“Chinese（Simplified）（简体中文）”。选择完成后，单击“Next”按钮，如图 2-34 所示。 

 
图 2-34  选择语言 

（5）键盘布局直接选择默认的“U.S.English”后，需要在弹出窗口中输入序列号。序列号是一个 16

位的字符串，在安装过程中用于决定用户所订阅的 RHEL 5.x 所支持的软件包。从 RHEL 5.x 开始 RHEL 安

装程序会根据序列号决定用户可以安装哪些软件包，这样 RedHat 不需要为不同选项的发行版制作多个单

独的安装包。这里可以选择“Skip entering Installation Number”跳过只安装基本的软件包，如图 2-35 所示。 

 
图 2-35  选择键盘布局 

其他的软件包也可以在安装的后续步骤中或安装完成后手工配置安装。 
提

示 
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（6）因为是第一次安装操作系统，硬盘没有进行过程初始化，在提示初始化时直接选择“YES”即可。 

（7）在选择硬盘分区方式窗口中，RHEL 5.x 提供了以下四种选择（如图 2-36 所示）。 

Remove all partitions on selected drives and create default layout.：在选择的硬盘上删除所有分区，并以默

认方式建立 RHEL 5.x 所需分区。 

Remove linux partitions on selected drives and create default layout.：在选择的硬盘上删除 Linux 分区，并

以默认方式建立 RHEL 5.x 所需分区。 

Use free space on selected drives and create default layout.：使用选择硬盘上剩余空间建立 RHEL 5.x 所需

分区。 

Create custom layout.：自定义分区。 

分区应该是整个安装过程中最复杂的部分。对于初学者，在这里可以选择“Remove all partitions on 

selected drives and create default layout.”，但是还是推荐选择“Create custom layout.”根据需要定义各个分

区。本章中选择“Create custom layout.”，选择完成后，单击“Next”按钮。 

（8）单击“New”按钮，在弹出的窗口中手动创建分区。在弹出的窗口中的“Mount Point”选择“/”

分区，“File System Type”选择“ext3”，“Size”处输入分区大小。使用相同的方法依次建立“/home”、“/usr”、

“/usr/local”、“/var”。使用相同的方法建立“/boot”，分区大小定义为 150～200MB，如图 2-37 所示。 

 
图 2-36  选择硬盘分区方式 

 
图 2-37  建立分区 
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在创建分区时需要选择 3 个重要的信息：“Mount Point”挂载点，在 Linux 系统中分区必须指定一

个目录作为挂载点后，分区才可以使用；“File System Type”文件系统，安装程序可以使用 ext2、ext3、

vfat 文件系统用于保存文件，通过 ext3 是 Linux 文件系统的默认格式，除了以上 3 种以外还包括 swap

（交换分区）、RAID、LVM（逻辑卷管理）3 种特殊的文件系统；“Size”分区大小，可以指定为“Fixed size”

（固定大小）、“Fill all space up”（有限分区，分区在建立时只有“Size”的容量，当用完时可以增大，但

最大只有该值）、“fillto maximum allowable size”（非限定分区，分区在建立时只有“Size”的容量，当

用完时可以增大，直到用完硬盘剩余空间为止）。 

（9）单击“New”按钮，在弹出窗口的“File System Type”选择“swap”，分区大小定义为物理内存

的 1.5～2 倍，选择完成后，单击“Next”按钮。 

（10）选择 GRUB 存放分区及启动菜单显示窗口直接单击“Next”按钮。 

（11）如果使用 DHCP 获取 IP 地址可直接单击“Next”按钮。如果需要手动配置 IP 地址，则单击“Edit”

按钮在弹出窗口中选择“Enable IPv4 support”下面的“Manual configuration”后，输入 IP 地址及子网掩码，

如果不需要使用 IPv6则取消“Enable IPv6 support”完成后单击“OK”按钮，可选择输入默认网关“Gateway”、

首选 DNS 服务器 IP 地址“Primary DNS”、其他 DNS 服务器 IP 地址“Secondary DNS”。如果希望定义计

算机名称可选择“Hostname”下面的“manually”后输入计算机名称。选择完成后，单击“Next”按钮，

如图 2-38 所示。 

 
图 2-38  配置 IP 地址 

（12）时区选择“Asia/ShangShi”后，单击“Next”按钮，如图 2-39 所示。 

 
图 2-39  时区选择 

（13）设置 root 用户密码，由于 root 用户对系统的重要性，在设置密码时一定要保证密码的强度。输

入完成后，单击“Next”按钮，如图 2-40 所示。 

提
示 
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图 2-40  设置 root 密码 

（14）在选择安装软件窗口勾选立即定制软件包“Customize now”后，单击“Next”按钮，如图 2-41

所示。 

 
图 2-41  定制软件包 

（15）在选择软件包时，可以不选中服务器不必要的软件包（如“Sound and Video”），但推荐将“Base 

Sysetem”→“System Tools”勾选，选择完成后单击“Next”按钮，如图 2-42 所示。 

 
图 2-42  软件包选择 
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（16）等待安装结束后，单击“Reboot”按钮重新启动计算机，如图 2-43 所示。 

 
图 2-43  重新启动 

（17）启动完成后，需要对 RHEL 5.x 进行初始设置。在同意许可协议后，防火墙设置选择“Disable”。

防火墙是整合在 Linux 内核中的，这里关闭只是将默认规则改为允许所有通信，选择完成后，单击“Forward”

按钮，如图 2-44 所示。 

 
图 2-44  关闭防火墙 

（18）在 SELinux 状态窗口选择“Disabled”模式，选择完成后，单击“Forward”按钮，如图 2-45 所

示。 

SELinux（SELinux 官方网站：http://www.nsa.gov/selinux/）是 Security-Enhanced Linux（安全增强式

Linux）的缩写，是一种强制存取控制的实现。SELinux 主要由美国国家安全局开发，并于 2000 年 12 月

22 日发行给开放源代码的开发社区。按照美国国家安全局 SELinux 小组的定义“SELinux 是一组给 Linux

内核的修补程序，并提供一些更强、更安全的强制存取控制架构来与内核的主要子系统共同运作。基于

机密及完整性原则，它提供一个架构来强制信息的分离，以对付入侵的威胁或任何企图略过安全架构的

应用程序。借此限制恶意或设计不良的程序可能造成的破坏。它包含一组安全性原则状态设定文件的范

本，以符合一般的安全性目标”。在 2.6 版的 Linux 内核中已整合 SELinux，因此独立的修补程序也已经

不需要了。SELinux 无疑使原本就以安全见长的 Linux 系统的安全性有了质的飞越，但对于初学者还是

推荐配置 SELinux 处于“关闭”（Disable）状态，这主要是希望学习时不会受到 SELinux 的干扰。如果

想了解 SELinux 在“开启阻挡”（Enforcing）状态下的运行情况，又不想因为 SELinux 影响正常的学习

实验可以将其状态配置为“提示”（Permissive），这样当 SELinux 碰到不允许的操作进行时会提示用户

但不会正真阻止用户的操作。 

提 示 
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图 2-45  开启 SELinux 

（19）在 Kdump 窗口可直接单击“Forward”按钮，如图 2-46 所示。 

 
图 2-46  Kdump 

Kdump 是一种内核崩溃转储机制。崩溃转储数据可以从一个新启动的内核的上下文中获取，而不是

从已经崩溃的内核的上下文获取。当系统崩溃时，Kdump 使用 kexec 启动到第二个内核。第二个内核通

常叫做捕获内核（capture kernel），以很小内存启动，并且捕获转储镜像。 

（20）在日期及时间选择窗口可以手动调整日期及时间，如果可以访问 Internet 或网络中有 NTP 服务

器可以选择“Network Time Protocol”后，输入 NTP 服务的 IP 地址或 FQDN，选择完成后，单击“Forward”

按钮，如图 2-47 所示。 

 
图 2-47  选择 NTP 服务器 

提 示 
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NTP 是 Network Time Protocol（网络时间协议）的缩写，是一个用于同步计算机时钟的网络协议，

它可以使计算机与其他服务器或时钟源（如石英钟、GPS 等）进行时间同步，进行高精度的时间校正（理

论上局域网内与标准时间差小于 1 毫秒，广域网上与标准时间差小于几十毫秒），而且 NTP 支持使用加

密确认的方式防止恶意的协议攻击。 

（21）选择不注册 RHN（如图 2-48 所示）后暂时先不建立其他用户，其他步骤直接使用默认选择即可。 

 
图 2-48  RHN 注册 

 

RHN 是 Red Hat Network（红帽网络）的缩写，RHN 是一个基于互联网的管理一个 Red Hat 企业 Linux

网络的解决方案。所有的安全警告（Security Alert）、错误修正警告（Bug Fix Alert）及功能增强警告

（Enhancement Alert）都可以直接从 RHN 上下载获得。所有购买 RHN 的用户都可以获得基于 Web 的 RHN

支持服务。 

（22）在完成安装后，在用户名处输入“root”按回车键并输入安装中为 root 用户配置的密码即可登录

到系统，如图 2-49 所示。 

 
图 2-49  系统登录 

2.3.3  命令输入 

登录后怎么是图形界面？在哪里输入命令？在安装 RHEL 5.x 时默认安装了 GNOME 桌面环境，如果

需要输入命令可在桌面单击鼠标右键后选择“打开终端”（“Open Terminal”），如图 2-50 所示。 

提 示 

提 示 
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图 2-50  打开终端 

 

在 KDE 桌面环境中输入命令的终端窗口是在桌面单击鼠标右键后选择 console。 

除了可以在图形界面中使用“打开终端”输入命令以外，RHEL 5.x 还为用户提供了 6 个可以使用的“虚

拟控制台”，使用“Ctrl+Alt+F1”到“Ctrl+Alt+F6”的 6 个组合键访问这 6 个虚拟控制台，每个控制台对

应这 6 组功能键中的一个（如果是在 VMware Workstation 中使用 RHEL 5.x，推荐使用 2.1 中的方法修改

VMware Workstation 默认的快捷键，以免与 RHEL 5.x 的快捷键发生冲突）。在虚拟控制台中可以通过

“Ctrl+Alt+F7”组合键返回图形界面。 

在使用虚拟控制台开始会话时，屏幕如图 2-51 所示，登录时需要输入用户名按回车键后输入密码，成

功登录后会出现欢迎用户的 Shell 提示，如图 2-52 所示。 

图 2-51  虚拟控制台 

 
图 2-52  登录虚拟控制台 

用户可以从任何终端上输入“who”命令，然后按回车键来判断有哪些用户在系统上及及登录方式，

如图 2-53 所示。 

 
图 2-53  输入“who”命令 

现在我们了解了在哪里可以输入命令，先来试试几个最基本的命令。 

关闭系统。 

[root@srv ~]# poweroff      

重新启动计算机。 

[root@srv ~]# reboot        

清除屏幕所有内容。 

[root@srv ~]# clear         

提 示 



                                                                     专业始于专注 卓识源于远见 

 
 
 

‐  25  ‐             
 

2.3.4  VMware Tools 安装 

如果是在 Vmare Workstation 中安装使用 RHEL 5.x，推荐安装“VMware Tools”，该工具可以让鼠标在

宿主机与虚拟机之间方便地切换、可以让虚拟机中的时间保持与宿主机同步、可以让宿主机与虚拟机之间

共享剪切板的内容。具体安装步骤如下。 

（1）选择 Vmare Workstation 菜单“VM”→“Install VMware Tools…”。 

（2）在桌面单击鼠标右键后选择“打开终端”并输入如下命令。 

挂载光盘驱动器。 

[root@srv ~]# mount /dev/cdrom /mnt      

进入 root 用户家目录。 

[root@srv ~]# cd                        

解压 VMware Tools。 

[root@srv ~]# tar -xvzf /mnt/VMwareTools-8.1.3-203739.tar.gz     

进入解压后的目录。 

[root@srv ~]# cd vmware-tools-distrib/      

运行 VMware Tools 安装脚本，在运行过程中对所有提示选择的内容直接按回车键，只有最后一

个提示可根据需要选择分辨率。 

[root@srv ~]# ./vmware-install.pl 

对于初学者，使用 Vmare Workstation 进行学习时，推荐登录到系统后，使用 Vmare Workstation 提

供的快照功能对系统进行备份，这样以后在学习过程中可以随时还原到系统初始状态。 

 

  Windows 7/Fedora 12 和平共处 

Windows 7 是微软最新的客户端操作系统，应该说 Windows 7 是微软继 Windows XP 之后推出的最成

功的客户端操作系统。Fedora 12 也是 Fedora 目前最新的版本，如果想在自己的计算机而不是虚拟机中使

用 Linux，又因为工作等一些原因暂时还不能抛开 Windows，那安装一个双系统的计算机应该是个不错的

选择，另外经常使用 Fedora 也是提高自己 Linux 水平一个很好的途径。下面将在一台安装了 Windows 7 操

作系统的计算机（该计算机硬盘分区情况如图 2-54 所示）上通过 Fedora 12 的 ISO 文件安装一个 Windows 

7 和 Fedora 12 并存的双系统，具体操作步骤如下。 

 
图 2-54  硬盘分区 

提 示 
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（1）下载 Fedora 12（HTTP 下载地址：http://mirrors.163.com/fedora/releases/12/Fedora/i386/ 

iso/Fedora-12-i386-DVD.iso ， 不 支 持 断 点 续 传 ； BT 种 子 下 载 地 址 ： http://torrent.fedorapr 

oject.org/torrents//Fedora-12-i386-DVD.torrent）的 ISO 文件。 

（2） 将 Fedora-12-i386-DVD.iso 得到硬盘中的一个目录（该目录所在分区必须是一个 NTFS 分区），

本章中复制到  “D:\”并将 Fedora-12-i386-DVD.iso 文件中 isolinux、 images 两个目录解压到与

Fedora-12-i386-DVD.iso 同一个目录。 

（3）下载 GRUB4DOS（下载地址：http://nchc.dl.sourceforge.net/project/grub4dos/GRUB4DOS/ 

grub4dos%200.4.4/grub4dos-0.4.4.zip）后，将 grldr、grldr.mbr 两个文件解压到“C:\”。 

（4）在“C:\”下建立一个名为“menu.lst”的文件，并在文件中加入如下内容。 

default 0 

timeout 3 

splashimage=(hd0,6)/grub/splash.xpm.gz 

hiddenmenu 

title Windows 7 

find --set-root --ignore-floppies /bootmgr 

chainloader /bootmgr 

 

title Install Linux 

kernel (hd0,2)/isolinux/vmlinuz    #本章中 Fedora映像文件在 D盘所以这里是(hd0,2)。 

initrd (hd0,2)/isolinux/initrd.img 

（hd0,2）表示第一块硬盘的第三个分区，由于在 Windows 7 的系统中会有一个保留分区，所以 D 盘

成了第三个分区，在使用时推荐通过 Windows 7 的磁盘管理工具查看 Fedora 映像文件解压后是存放在第

几个分区。 

（5）将 GRUB 增加到 Windows 7 的引导菜单中。 

#执行完成该命令后，会返回一个 GUID，如图 2-55所示。 

bcdedit /create /d "Grub4Dos" /application bootsector 

#执行以下三个命令时，需将{GUID}替换为上一个命令所显示的 GUID，如图 2-56所示。 

bcdedit /set {GUID} device partition=C: 

bcdedit /set {GUID} path \grldr.mbr 

bcdedit /displayorder {GUID} /addlast 

 
图 2-55  bcdedit 生成 GUID 

 

提 示 
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图 2-56  bcdedit 

（6）重新启动计算机后，在启动菜单中选择“Grub4Dos”，如图 2-57 所示。 

（7）在“Grub4Dos”菜单中选择“Install Linux”进入 Fedora 12 的安装程序，如图 2-58 所示。 

 
图 2-57  选择 Grub4Dos 菜单 

 
图 2-58  Install Linux 

 

（8）选择系统语言为“Chinese(Simplified)”后按回车键，如图 2-59 所示。 

（9）选择键盘类型为“us”后按回车键，如图 2-60 所示。 

 
图 2-59  语言选择 

 
图 2-60  键盘类型 

（10）选择 Fedora 安装来源为“Hard drive”后按回车键，如图 2-61 所示。 

（11）由于前面将 Fedora 映像文件解压到“D:\”，所以在选择 Fedora 安装文件所分区时应为“/dev/sda3”

并按回车键，如图 2-62 所示。 

 
图 2-61  安装来源 

 
图 2-62  安装文件目录 

（12）完成安装目录选择后就进入了图形界面，开始 Fedora 的安装，在摘要页直接单击“Next”按钮。 

（13）选择显示语言，这里可以选择“Chinese（Simplified）（中文（简体））”。选择完成后，单击“Next”

按钮，如图 2-63 所示。 

（14）键盘布局直接选择默认的“美国英语式”。选择完成后，单击“下一步”按钮，如图 2-64 所示。 
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（15）根据需要输入主机名后单击“下一步”按钮，如图 2-65 所示。 

 
图 2-63  选择语言 

 
图 2-64  选择键盘布局 

 
图 2-65  输入主机名 

（16）由于在前面选择了系统语言为简体中文，所以时区选择时 Fedora 会自动选择“亚洲/上海”，直

接单击“下一步”按钮，如图 2-66 所示。 

 
图 2-66  时区选择 
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（17）配置 root 用户的密码后单击“下一步”按钮，如图 2-67 所示。 

 
图 2-67  配置根用户密码 

（18）选择“建立自定义的分区结构”后单击“下一步”按钮，如图 2-68 所示。 

 
图 2-68  自定义分区 

（19）单击“New”按钮，在弹出窗口的“Mount Point”选择“/”分区，“File System Type”选择“ext4”，

Size 处输入分区大小。使用相同的方法依次建立“/home”、“/usr”、“/usr/local”、“/var”。使用相同的方法

建立“/boot”，分区大小定义为 150～200MB。完成后单击“New”按钮，在弹出窗口的“File System Type”

选择“swap”，分区大小定义为物理内存的 1.5～2 倍，选择完成后，单击“下一步”按钮。 

（20）在配置“引导操作系统列表”后直接单击“下一步”按钮。 

（21）在选择安装软件窗口选择“现在定制”后，单击“下一步”按钮，如图 2-69 所示。 

 
图 2-69  自定义安装 
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（22）在自定义安装软件包窗口，可以根据需要选择要安装的软件包。为了以后使用方便推荐勾选“开

发”→“开发工具”，完成后，单击“下一步”按钮，如图 2-70 所示。 

 
图 2-70  选择软件包 

（23）完成软件包选择后 Fedora 安装程序将开始安装，等待安装完成后单击“重新引导”按钮，如图

2-71 所示。 

 
图 2-71  完成安装 

（24）重新启动后 Fedora 的 GRUB 将成为引导程序，如果不做任何选择将直接进入 Fedora 12，按任意

键后进行启动选择界面（如图 2-72 所示），其中“Other”表示进入 Windows 7。此处还是需要进入 Fedora

完成后续安装。 

 
图 2-72  选择启动操作系统 
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（25）在“欢迎”和“许可信息”窗口直接单击“前进”按钮后进入“创建用户”窗口，Fedora 与 RHEL 

5.x 不同，在默认情况下 Fedora 不允许使用 root 用户登录，所以在这里至少需要建立一个用户，如图 2-73

所示。 

 
图 2-73  建立用户 

（26）在“日期和时间”窗口直接单击“前进”按钮后，在“硬件信息”窗口单击“完成”按钮。 

（27）等待 Fedora 配置完成后，即可登录系统开始使用 Fedora 12，如图 2-74 所示。 

 

 

图 2-74  登录系统 

  实验任务 

通过 VMware Workstation 建立一台虚拟机后，使用 RHEL 5.x 的 ISO 文件为虚拟机安装 RHEL 5.x 并

满足以下要求。 
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（1）硬盘分区。 

 /：10G 

 /home：50G 

 /swap：RAM*2 

 /boot：200M 

（2）网络配置。 

 IP 地址：192.168.159.200 

网关：192.168.159.1 

 DNS 服务器：192.168.159.15 

主机名：lab.example.zqin 

（3）安全配置。 

关闭防火墙 

禁止 SELinux 
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